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Preface

Welcome to FaxTalk Communicator, the easy to use telephony software
designed by Thought Communications. When combined with a capable
voice modem, FaxTalk Communicator provides voice messaging,
speakerphone, and fax capabilities to your computer running Windows 95
or Windows NT 4.0.

FaxTalk Communicator is comprised of four main applications—the
CallControl program that handles all of the communications between the
modem and software; the Fax Viewer with its fax annotation and viewing
functions; the Program Configuration with its program settings and
options; and the FaxTalk Communicator program that provides central
management of voice messages, send and receive fax capabilities, and
speakerphone operation.

About this guide

FaxTalk Communicator is designed to be easy to use and provide you with
all the features and functions you need. This guide provides instructions
and details to help you get the most from FaxTalk Communicator and your
modem. It does not describe every option or feature available in FaxTalk
Communicator, but instead, describes the important and commonly used
features and options. For detailed information regarding every setting and
option, please see the online help system.

This guide is divided into nine chapters, each devoted to providing
information and instructions related to a specific portion of FaxTalk
Communicator.

Chapters one and two focus on software installation, configuration, and
setting up a voice messaging system.

Chapters three through nine focus on working with the various programs
that comprise FaxTalk Communicator.

Online help

FaxTalk Communicator also includes a comprehensive online help system
for questions about using the program's features and setting individual
options.
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Conventions

This guide assumes that you are familiar with using either the Microsoft
Windows 95 or Windows NT 4.0 operating system. This includes an
understanding of how to:

• use a mouse or other pointing device to click, double-click, drag,
access right-click menus, and select information

• scroll using scroll bars

• open and close program windows and applications

• navigate through an icon and menu driven application

If you have any questions about these skills, consult your Windows
documentation for assistance.
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Chapter 1

Getting Started

FaxTalk Communicator's installation is comprised of a few, easy to follow
steps. This chapter walks you through the process, from verifying software
requirements to registering your new application.

Installation Checklist

Before you install FaxTalk Communicator, be sure you have received a
complete package, and confirm your system meets the requirements to run
FaxTalk Communicator.

Package contents

Please check the contents of the FaxTalk Communicator package to make
sure you have received all the materials.

The FaxTalk Communicator package contains:

• The FaxTalk Communicator program CD-ROM

• FaxTalk Communicator User's Guide

• Registration card

Software requirements

Your system must meet minimum requirements to install and operate
FaxTalk Communicator. These requirements are:

• IBM PC or 100% compatible with a 486 66MHz or higher processor,
Pentium 90 or higher recommended.

• 8 megabytes of RAM, 16 or more recommended.

• 11 megabytes of hard disk space available.

• A voice capable modem. Speakerphone operations require
speakerphone support in the modem.

• Windows 95 or Windows NT 4.0 Workstation.

• If using the Caller ID or Distinctive Ring functions of FaxTalk
Communicator, you must have Caller ID and Distinctive Ring service
from your phone company.
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Installing the software

Before you can begin using FaxTalk Communicator, the program must be
installed on your hard drive. Prior to installing FaxTalk Communicator, make
sure your modem is installed correctly and functioning.

To install FaxTalk Communicator:

1. Close all other programs running in Windows. If you are installing
FaxTalk Communicator under Windows NT 4.0, you must log in as the
Administrator before beginning the installation.

2. Insert the FaxTalk Communicator CD-ROM or Disk 1 into the
appropriate drive.

3. Select Run from the Windows Start menu. The Run dialog appears.

Note: If you are installing from the CD-ROM and Autorun
is enabled in Windows, the setup program automatically
begins.

4. Type d:\setup and click OK. Substitute the appropriate drive letter if
the installation disk is located in another drive.

5. The FaxTalk Setup program begins. Follow the on-screen instructions to
complete the installation. Refer to the next section, FaxTalk Program
Configuration.

FaxTalk Program Configuration

After the appropriate FaxTalk Communicator files are copied to your
system, the FaxTalk Program Configuration screen displays so you can
indicate how you want the program to work with your modem, phone line,
and system. The program presents several configuration screens to allow
you to configure the software to work the way you do. Click Next to
continue with the installation.

The instructions and dialogs described in the next section refer to
subsequent operations performed after the initial installation has been
completed. During installation, the configuration screens contain Next and
Previous buttons, and you need to select all of the configuration options
desired on a given dialog before clicking the Next button.
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General Settings

FaxTalk Communicator includes various settings for handling calls. The
General tab of the FaxTalk Program Configuration contains settings for
automatically answering the phone, toll saver, call screening, and call
notification.

Figure 1-1  General Configuration Screen

Setting Auto Answer and number of rings

Under the General tab, click the checkbox next to Auto Answer to indicate
you want FaxTalk Communicator to automatically answer the phone. You
can then use the up and down arrows to increase or decrease the number
of rings you want FaxTalk Communicator to wait before answering.

If you choose not to have FaxTalk Communicator automatically answer the
phone, you can still answer calls manually using the Answer Now
command on Call Control's right-click menu. See Chapter 3, Call Control
for more information.
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Using toll saver

The Toll Saver feature instructs the software to wait two extra rings before
answering when there are no new messages or faxes. When you call from
a remote phone to retrieve messages or faxes, you can then tell by the
number of rings whether or not there are any new messages or faxes. If
there are no new messages or faxes, you can hang up before the phone is
answered to avoid telephone charges.

To enable Toll Saver:

1. Click the General tab.

2. Check the Enable Toll Saver box

3. Click OK or Apply to have the change take effect.

Screening calls

The screen calls feature enables you to listen to the caller as they are
leaving a message. This enables you to determine who the caller is and
decide whether to let the caller continue leaving a message, or interrupt
the message and talk to the caller. To stop FaxTalk Communicator from
taking a message, press the * key on a phone connected to the same
phone line as your modem.

To enable Call Screening:

1. Click the General tab.

2. Check the Screen Calls box.

3. Click OK or Apply to have the change take effect.

Announcement settings

FaxTalk Communicator includes various settings for announcing new
messages and faxes. The Announce tab of the FaxTalk Program
Configuration contains all of the announcement options available with
FaxTalk Communicator.
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Figure 1-2  Announce Configuration Screen

Announcing new messages and faxes

When FaxTalk Communicator receives a message or fax, it can flash the
CallControl icon in the Windows taskbar, play a .WAV file at a set interval,
or flash the keyboard Scroll Lock key.

To specify the announcement options for FaxTalk Communicator:

1. Click the Announce tab.

2. Check the desired announcement options in the Announce new
Messages and Faxes section.

3. Click OK or Apply to have the change take effect.

Automatically print received faxes

FaxTalk Communicator can automatically print a newly received fax to a
selected printer.

To enable automatic printing of received faxes:

1. Click the Announce tab.

2. Check the Automatically Print Received Faxes box.

3. Click OK or Apply to have the change take effect.
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User settings

The User tab in FaxTalk Program Configuration includes the User ID and fax
number that appear on your faxes, and settings for coversheets that you
send.

Figure 1-3  User Configuration Screen

Setting the User ID information

When sending faxes, FaxTalk Communicator places information at the top
of each page called a header. The header contains the User ID, fax number,
number of pages, and the time and date the fax was sent. Typically, the
User ID is your name or your company's name, and the fax number is the
number of your fax machine or PC running FaxTalk Communicator.

Automatically attaching a coversheet

FaxTalk Communicator can automatically attach a coversheet everytime
you send a fax. A coversheet typically includes the receiver's name and
number plus, the total number of pages in the fax and a memo area.
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To automatically attach a coversheet when sending a fax:

1. Click the User tab.

2. Check the Automatically Send a Coversheet box.

3. Click OK or Apply to have the change take effect.

Selecting a coversheet logo

The coversheet logo appears at the top of the coversheet and typically
contains a company logo. You can select a default coversheet logo to be
added to the coversheet when sending faxes.

To select a default coversheet logo:

1. Click the User tab.

2. Select the coversheet logo from the list of logo files in the Logo field.

3. Click OK or Apply to have the change take effect.

Fax settings

The Fax settings specify the type of page you normally transmit. The
settings you specify here are used as the defaults when you send faxes. You
can modify these settings when you are faxing from applications by clicking
Setup in the application's Print dialog.
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Figure 1-4  Fax Configuration Screen

Fax resolution

Choose the default resolution that faxes are sent in. Fine resolution is
approximately 200 x 200 dpi and Standard resolution is approximately 200
x 100 dpi. Using Fine resolution ensures a cleaner fax is received, but
Standard resolution takes less time to transmit.

To set the fax resolution:

1. Click the Fax tab.

2. Under Resolution, select either Standard or Fine Mode.

3. Click OK or Apply to have the change take effect.

Error Correction Mode

When Error Correction Mode (ECM) is enabled, faxes that are sent to other
ECM capable machines are divided into blocks that enable a fax to be sent
over noisy phone lines. If the receiving fax machine does not support ECM,
the fax is sent normally.
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To enable Error Correction Mode:

1. Click the Fax tab.

2. Click the Error Correction Mode box.

3. Click OK or Apply to have the change take effect.

2-D encoding

When 2-D encoding is enabled, faxes that are sent to other 2-D capable
machines are compressed and transmitted in a shorter period of time. If the
receiving fax machine does not support 2-D, the fax is sent normally.

To enable 2-D encoding:

1. Click the Fax tab.

2. Click the 2-D Encoding box.

3. Click OK or Apply to have the change take effect.

Modem settings

FaxTalk Communicator uses TAPI to communicate with your modem.
Before you can use FaxTalk Communicator, you need to configure the
modem to be used by the program.

Figure 1-5  Modem Configuration Screen
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Selecting a modem

You will need to select the modem you want to use with FaxTalk
Communicator.

To select a modem to be used by FaxTalk Communicator:

1. Click the Modem tab.

2. Select the desired modem from the Selected Modem list.

3. Click OK or Apply to have the change take effect.

Setting modem options

The Modem tab also contains settings for modem speaker, speed and
dialing preferences. The Modem Speaker section sets the volume FaxTalk
Communicator uses to play sounds through the modem speaker and when
the sounds will be heard. The Modem Speed section controls the maximum
fax send and receive speeds the modem uses. The Dialing Preferences
setting allows access to the Window's Dialing Properties. FaxTalk
Communicator uses the Window's Dialing Properties for dialing numbers.

Configuring advanced modem properties

The Advanced Modem Properties dialog allows you to configure a modem
that was not recognized properly by FaxTalk Communicator or if problems
occur with the driver settings for the modem. It is highly recommended
that the settings in this dialog not be changed unless you are absolutely
sure the modem hardware supports the settings you select. The settings
found in this dialog can cause the software and modem to stop functioning
if not set properly. If an incorrect setting is selected and the software stops
functioning with the modem, click on the Reset Defaults button to return
the settings to the modem's defaults.

To access the Advanced Modem properties, click the Modem tab and then
click Advanced. The Advanced Modem Properties dialog appears.
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Figure 1-6  Advanced Modem Properties Screen

Directory settings

You can set the location of the directories used by various components of
FaxTalk Communicator. This gives you the flexibility of setting directories on
multiple hard disks, or separating the data directories apart from the
program files. For instance, you may want to have the Inbox and Outbox
directories on a separate hard disk for backup purposes.

Figure 1-7  Directories Configuration Screen
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To change a directory:

1. Click the Directories tab.

2. Click Browse next to the directory listing you want to change.

3. Select the new directory location from the Select Directory dialog, and
click OK.

Note: Existing data will not be copied into the new
directories. You will need to manually copy the data files
from the old directory to the new one.

Making changes to the program configuration

You can always make changes to the configuration settings by clicking
Configure on CallControl’s right click menu, clicking the Program
Configuration button on FaxTalk Communicator’s toolbar, or by double-
clicking on the FaxTalk Program Configuration icon in the FaxTalk
Communicator 4.0 folder.

Uninstalling FaxTalk Communicator

There may be times when you need to uninstall your FaxTalk
Communicator software. Uninstalling the program is a simple procedure.

To uninstall FaxTalk Communicator:

1. From the Windows desktop, click Start, select Settings, and then click
Control Panel.

2. Double-click Add/Remove Programs.

3. In the list of installed software, select FaxTalk Communicator.

4. Click Add/Remove. The uninstall program begins.

5. Follow the uninstall program’s instructions and reboot the computer to
complete the uninstallation.

Note: The uninstall program will not delete directories
under FaxTalk Communicator if they contain data files
created after the installation such as received messages or
faxes.
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Launching FaxTalk Communicator

Once you have installed and configured the FaxTalk Communicator
software, you can launch the program by clicking the Windows Start
button, selecting Programs, FaxTalk Communicator 4.0, and clicking the
FaxTalk Communicator 4.0 icon.
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Chapter 2

Setting up Voice Messaging

With FaxTalk Communicator's powerful voice messaging capabilities you
can create a sophisticated voice mail system that gives your small business
the appearance of a large corporation. Features include support for
multiple mailboxes with individual password protection, fax on demand,
message notification, remote access and more.

Planning your messaging system

When you first installed FaxTalk Communicator, a single Voice/Fax mailbox
with a generic greeting was created. This greeting instructs callers how to
leave a message for you, however, it does not convey any information
about your particular system. For example, if you set up mailboxes for
different people within your organization, you should record a greeting that
instructs callers how to reach individual mailboxes. See Greeting Samples at
the end of this chapter for sample greeting ideas.

Single mailbox vs. multiple mailboxes

FaxTalk Communicator has been developed to support single and multiple
mailbox configurations. If you do not need separate mailboxes, you can
operate FaxTalk Communicator in single mailbox mode as soon as the
software is installed.

Using multiple mailboxes is just as easy, but does require additional
configuration. There are many advantages to using a multiple mailbox
messaging system:

• Assign a specific mailbox to each user to ensure message privacy.

• Assign mailboxes to departments to give the appearance of a large
company.

• Setup informational announcements informing callers of products and
services you offer.

You may want to diagram your ideal mailbox system to determine how
many mailboxes you will need and how the callers will navigate the system.

There is no limit to how many mailboxes can be created.
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Types of mailboxes

FaxTalk Communicator provides you with three different types of mailboxes
to fit all your messaging needs.

Voice/Fax

The Voice/fax mailbox is the basic type of mailbox used in FaxTalk
Communicator. These mailboxes can receive both voice messages and
faxes.

Fax on Demand

Fax on Demand mailboxes enable callers to request faxable documents
such as data sheets, price lists, brochures, etc. You can configure up to 100
documents per Fax on Demand mailbox.

When a caller accesses a Fax on Demand mailbox, they are prompted to
select a document to be faxed to them by entering the corresponding
document number that you have assigned to the document. The caller can
request multiple documents to be sent to them at the same time.

Data

Data mailboxes are used to provide callers with access to Windows 95
compatible data applications such as remote access software, Windows 95
Dial Up Networking, BBS software, etc.

Configuring mailboxes

The FaxTalk Mailbox Configuration program is used to manage the
mailboxes in your voice messaging system. With the Mailbox Configuration
program you can create, remove, and modify mailboxes.

To open the FaxTalk Mailbox Configuration program, click the Mailbox
Configuration button on the FaxTalk Communicator toolbar. The FaxTalk
Mailbox Configuration program appears.
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Figure 2-1  Mailbox Configuration Screen

Mailbox manager password

You can limit access to the Mailbox Configuration program by assigning a
mailbox manager password. Once a Mailbox Manager password is
assigned, the Mailbox Configuration program requires a password before
opening.

Assigning the password

To assign the password, enter a 1 to 8 digit security code in the Mailbox
Manager Password field. Click Close to invoke the password setting.

Note: The mailbox manager password is also used when
picking the All Mailboxes selection in the Mailboxes list in
the Inbox.

Logging into Mailbox Configuration

If the Mailbox Configuration program is password protected, the Manager
Login dialog displays. Enter the Mailbox Manager Password and click OK.
The Mailbox Configuration program opens.
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Adding mailboxes

You can add as many of the three types of mailboxes FaxTalk
Communicator supports that you need.

To add a mailbox:

1. In the Mailbox Configuration window, click Add. The Add Mailbox
dialog appears.

Figure 2-2  Add a New Mailbox Screen

2. Select the type of mailbox you want to add.

3. Enter the Mailbox name as you would like it to appear in the software.
For example, you could name a mailbox “Bob’s Mailbox.”

4. Enter the mailbox number you want for this mailbox. Mailbox numbers
are used by callers to select the mailbox.

5. Click OK to add the mailbox.

Deleting mailboxes

You can remove mailboxes from your messaging configuration when you
no longer need them.

To delete a mailbox:

1. In the Mailbox Configuration window, select the mailbox you wish to
delete.

2. Click Delete.

3. Confirm that you want to delete the mailbox by clicking OK.
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Note: You cannot delete the mailbox currently assigned as
the default mailbox. You must first assign the default
mailbox to another mailbox before you can delete it.

Modifying mailboxes

You can change the settings of a mailbox at any time using the Mailbox
Configuration program.

To modify a mailbox:

1. In the Mailbox Configuration window, select the mailbox you want to
modify.

2. Click Modify.

3. The mailbox configuration settings appear. These settings will vary
depending on the type of mailbox you are modifying.

4. Make the desired changes and click OK.

Setting the default mailbox

When FaxTalk Communicator answers the phone it uses the settings of the
default mailbox. You can set any Voice/Fax mailbox to be the default
mailbox. The default mailbox is recognizable by a small red square in the
lower left corner.

To set the default mailbox:

1. In the Mailbox Configuration window, select the mailbox you wish to
make the default.

2. Click Set as Default. Click OK to exit Mailbox Configuration.

Recording a greeting

You can record a custom greeting to be played when a voice call is
received. Depending on your modem's capabilities, you can record your
greeting from the telephone handset, modem microphone, or multimedia
microphone.

To record a greeting:

1. In the Mailbox Configuration window, select the mailbox for which you
want to record the greeting.

2. Click Modify.

3. Click the Greeting Tab, and the greeting settings appear.
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Figure 2-3  Greeting Configuration Screen

4. Click New to create a new greeting

5. In the Greeting Recorder, select the recording device you want to
record the greeting from.

6. Click the Record button to begin recording. Click the Stop button
when you are finished.

7. Once you have recorded the greeting, click Save and save the greeting
to a file.

Selecting a greeting

You may want to record and use different voice greetings depending on
your needs. For instance, you could record a standard greeting, a greeting
to let customers know you are closed during lunch hour, and another to
use when you will be away for an extended period. You can easily change
the current greeting for any mailbox.

To select a greeting for a mailbox:

1. In the Mailbox Configuration window, select the mailbox for which you
want to change the greeting.

2. Click Modify.
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3. Click the Greeting Tab.

4. Select the desired greeting from the Greeting list and click OK.

Deleting a greeting

To delete a greeting:

1. In the Mailbox Configuration window, select the mailbox you want to
delete.

2. Click Modify.

3. Click the Greeting Tab.

4. Select the desired greeting from the Greeting list and click the Delete
button. You will be asked to confirm that you wish to delete the
selected greeting.

5. Click OK to delete the greeting.

Configuring voice/fax mailboxes

Voice/fax mailboxes are the basic type of mailbox used by FaxTalk
Communicator. These mailboxes can receive both voice messages and
faxes. You can also configure a Voice/fax mailbox to act as an announce
only or fax only mailbox.

To change the settings of a Voice/fax mailbox, select the desired mailbox
and click Modify. The Voice/fax mailbox dialog appears.
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Figure 2-4  Voice /Fax Mailbox General Configuration Screen

Setting the maximum message length

You can control the length of time a caller has to leave a message. Each
mailbox can be set to a specific message length of between 1 and 999
seconds.

To change the maximum message length:

1. In the Mailbox Configuration window, select the specific Voice/fax
mailbox.

2. Click Modify. The General tab for that mailbox displays.

3. Click the up or down arrows on the Maximum Message Length setting
to change the value. You can also type a new value directly into the
field.

4. Click OK to save the change.

Password protecting a mailbox

You can password protect individual Voice / Fax mailboxes for privacy. You
have the option of requiring a password for local access, local and remote
access, or just remote access.
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To set a mailbox password:

1. In the Mailbox Configuration window, select the specific Voice/fax
mailbox.

2. Click Modify. The General tab for that mailbox displays.

3. Enter a numeric password in the password field. If you want password
protection only when accessing the mailbox remotely, check the
Prompt for password with remote access only option.

4. Click OK to save the change.

Notification settings

FaxTalk Communicator includes new message and fax notification settings
for each Voice/fax mailbox. These notification settings include notification
by fax, voice and pager. To configure notification settings when modifying
a Voice/fax mailbox click the Notification tab. The Notification dialog
appears.

Figure 2-5  Voice / fax Notification
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Fax notification

You can have FaxTalk Communicator notify you of new messages and faxes
via fax. When new messages or faxes are received, FaxTalk Communicator
can dial the configured fax notification number and send a coversheet, or
forward the received faxes automatically.

To enable fax notification:

1. In the Mailbox Configuration window, select the specific Voice/fax
mailbox.

2. Click Modify.

3. Click the Notification tab, and check Enable Fax Notification. Enter the
number in the fax number field you want to have FaxTalk
Communicator call to deliver fax notifications.

4. Click Options to set fax notification options.

5. Click OK to save the change.

Fax notification options

The fax notification options include selecting the coversheet logo to use
when notifying via fax, number of times that fax notification will attempt
to notify of messages and faxes, and have fax notification automatically
forward received faxes.

Voice notification

You can have FaxTalk Communicator notify you of new messages and faxes
by voice call. When new messages or faxes are received, FaxTalk
Communicator will dial the configured voice notification number and allow
you to retrieve the messages and faxes.

To enable voice notification:

1. In the Mailbox Configuration window, select the specific Voice/fax
mailbox.

2. Click Modify.

3. Click the Notification tab, and check Enable Voice Notification. Enter
the number in the Voice number field you wish to have FaxTalk
Communicator call to deliver voice notifications.

4. Click Options to set the voice notification options.

5. Click OK to save the change.
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Note: When you use the voice notification feature, we
suggest creating and using a new greeting such as: "I am
trying to reach <your name>. Please call <your name> to
the phone. Press # to access the system and listen to your
messages."

Voice notification options

The voice notification options include the ability to select and record voice
messages that are played during voice notification. You can also set the
number of times that voice notification will attempt to notify you of new
messages and faxes.

Pager notification

You can have FaxTalk Communicator notify you of new messages and faxes
via pager. When new messages or faxes are received, FaxTalk
Communicator will dial the configured pager notification number and
transmit the number of received messages and faxes.

To configure pager notification:

1. In the Mailbox Configuration window, select the specific Voice/fax
mailbox.

2. Click Modify.

3. Click the Notification tab, and check Enable Pager Notification. Enter
the number in the pager number field you wish to have FaxTalk
Communicator call to deliver numeric pager notifications.

4. If desired, enter the number or codes you want to have FaxTalk
Communicator display on your numeric pager. Use the @F command
to display the total number of faxes in the mailbox, and the @M
command to display the total number of voice messages in the
mailbox.

5. Add the % character to the end of the dialing string to tell FaxTalk
Communicator to hang up.

6. Click the Options button to set pager notification options.

7. Click OK to save the change. Click OK again to exit Mailbox Setup.

Note: To have FaxTalk Communicator page you when and
display the total number of messages and faxes you would
enter 555-1212,,,,,5553232@M@F#% to have FaxTalk
Communicator dial 555-1212, wait 5 seconds and tell the
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pager to display 5553232, then the number of messages
(@M) and faxes (@F), then signal the pager company
(usually a #) and FaxTalk (%) to hang up.

Some pagers will allow you to use the * character to insert
a space between numbers. For example:
5553232*@M*@F#%”.

Creating an announce only mailbox

An announce only mailbox plays a greeting to the caller and then hangs up
without allowing them to leave a message. You can use an announce only
mailbox to provide information to callers such as location and business
hours or product information.

To configure an announce only mailbox:

1. In the Mailbox Configuration window, select the specific Voice/fax
mailbox.

2. Click Modify.

3. Click the Greeting tab. Select Hangup from the Default Action after
Greeting list.

4. Click OK to save the change.

Creating a fax only mailbox

A fax only mailbox begins receiving a fax as soon as someone accesses the
mailbox. You can use a fax only mailbox to automatically receive faxes and
bypass the voice messaging system. Setting the default mailbox to receive
fax only causes FaxTalk Communicator to act as a fax only application.

To create a fax only mailbox:

1. In the Mailbox Configuration window, select the specific Voice/fax
mailbox.

2. Click Modify.

3. Click the Greeting tab. Select Receive Fax from the Default Action after
Greeting list.

4. Click OK to save the change.

Configuring a fax on demand mailbox

Fax on Demand mailboxes provide callers with the ability to request faxable
documents such as data sheets, price lists, brochures, etc.
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When a caller accesses a Fax on Demand mailbox, they are prompted to
select a document to be faxed to them by entering the corresponding
document number. The caller can request multiple documents to be sent to
them at the same time. The selected fax documents are sent to the caller
on the same phone call.

Once a fax on demand mailbox is created you need to add documents to
the fax on demand list and assign numbers for callers to enter to access the
documents. To configure a fax on demand mailbox, select a fax on demand
mailbox from the Mailbox Configuration dialog, and click Modify. The Fax
on Demand Mailbox dialog appears.

Figure 2-6  Fax on Demand Mailbox General Configuration Screen

Note: When you create a Fax on Demand mailbox, you
should record a custom greeting that informs the caller
what documents are available and the document numbers
that are assigned. For a sample fax on demand greeting,
see the Greeting samples at the end of this chapter.

Adding documents

Once you have created a fax on demand mailbox you will need to add the
fax documents that callers can access.  You can configure up to 100
documents per Fax on Demand mailbox.
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To add documents to a fax on demand mailbox:

1. In the Mailbox Configuration window, select the specific Fax on
Demand mailbox.

2. Click Modify.

3. If you have fax document saved in the File Cabinet, you can highlight
the desired documents in the File Cabinet window, and click Add Files
to fax on Demand List. If you would like to attach other documents to
the Fax on Demand list, click Browse to select the files. Once the files
are selected they are added to the Fax on Demand list and
automatically assigned document numbers.

4. Click OK to save the changes.

Changing document properties

You can change the fax settings of a document on the Fax on Demand List
by highlighting the document and clicking Options. The options vary
depending on the type of file selected.

Changing document numbers

Document numbers are automatically assigned to documents when they
are first added to the Fax on Demand list. You can change the document
numbers at any time.

To change a document number:

1. Select the document from the Fax on Demand list and click the
Document # button. The Change Document # dialog appears.

Figure 2-7  Fax on Demand Change Document Number Screen

2. Enter the new document number in the New Document Number field
and click OK.

The new document number is assigned to the document.
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Configuring a data mailbox

Data mailboxes are used to provide callers with access to TAPI-compliant
data applications, such as remote access software or BBS software.

Note: You must have the data application running in order
to use this type of mailbox.

Once a data mailbox is created, you need to specify the type of data
application this mailbox will work with. To configure a data mailbox, select
the data mailbox from the Mailbox Configuration dialog and click Modify.
The Data Mailbox dialog appears.

Figure 2-8  Data Mailbox General Configuration Screen

There are three types of data applications that FaxTalk Communicator will
work with. Applications such as Procomm Plus are considered "Data Type
Applications". Please check with your data application vendor to determine
the type of your application.

Greeting samples

These are suggested sample greetings for different call-handling scenarios.
Of course, these should be modified to fit your particular needs:
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Home/personal

Single Mailbox: “Hello, this is the Jones residence. We cannot come to the
phone right now, but if you leave your name, number and a brief message
after the beep, we’ll get back to you as soon as possible.

Multiple Mailbox: “Hello, this is the Jones residence. We cannot come to
the phone right now. If you would like to leave a message for Bill, press
10#. To leave a message for Jenny, press 11# or to leave a message for
Alex, press 12#. Thank you.”

Small office/home office

"Thank you for calling North American BigCo, please enter the number of
the department you wish to reach. For marketing, press 11#. To reach
sales, press 12#, Accounting, press 13#, and for technical support, press
14#. Thank you."

Small business

"Welcome to the North American BigCo voice messaging system. If you
know the mailbox number you wish to access, enter it now followed by the
pound key. For company information, press 11#. To reach our fax on
demand system, press 22#. If you would like directions and store hours,
press 13#. Thank you."

Fax on demand #1

"This is the North American BigCo fax on demand service. Please note the
document numbers you want and enter them followed by pound key when
prompted. Enter 11# for our New Improved Product data sheet, enter 22#
for our current price list, enter 33# for our exclusive Till the End of Time
Product Warranty."

Fax on demand #2

"Welcome to the North American BigCo fax on demand service. If you
know the document number of the document you wish to receive, please
enter the document number followed by the pound key. To have a catalog
of all available documents sent to you, press 100#."

Data mailboxes

"You have reached the North American BigCo bulletin board service. Please
begin your data communications session now."
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Chapter 3

FaxTalk CallControl

FaxTalk CallControl is a program that resides in the Windows system tray
and handles incoming calls and outgoing faxes. This allows FaxTalk
Communicator to take messages and send faxes without having the main
application loaded.

Figure 3-1  CallControl icon in Windows System Tray

CallControl's right-click menu allows direct access to Sending a Fax,
launching the FaxTalk Communicator application, and the Fax Viewer.
CallControl also includes a status screen so you can determine what actions
are occurring in the software.

FaxTalk Status screen

The FaxTalk Status Screen provides status information for CallControl, and
will display status information for incoming and outgoing calls. The status
screen is divided into three sections. To display the FaxTalk Status screen,
double-click on the CallControl icon in the system tray. The FaxTalk Status
screen appears.

Figure 3-2  FaxTalk Status Screen



32

The top section displays the selected modem currently being used by
FaxTalk and the number of new messages and faxes currently received in
FaxTalk. The middle section contains the current activity of the selected
modem and a Hangup button to cancel a call in progress, such as a fax
being sent. The bottom section contains the number of faxes that are
waiting to be sent in the Outbox and when the next fax is scheduled to
send.

You can configure the status screen so that it will pop up when CallControl
is processing incoming or outgoing faxes. To have the status screen pop up
with incoming or outgoing faxes:

1. Click on the Program Configuration button on the FaxTalk
Communicator toolbar.

2. Click the Announce tab.

3. Check the Pop up FaxTalk Status while sending or receiving box.

4. Click OK to save the change.

Launching FaxTalk applications

You can use CallControl's right-click menu to launch the FaxTalk
Communicator application, Fax Viewer application or Send a Fax. This
allows for easy access to the main application as well as viewing and
sending faxes.

Changing configuration settings

You can access the FaxTalk Program Configuration directly from
CallControl's right-click menu by selecting Configure. This opens the
FaxTalk Program Configuration and allows you to change the software
configuration for FaxTalk Communicator.

Enabling auto answer

You can enable and disable CallControl's ability to automatically answer all
incoming calls directly from CallControl's right click menu. To enable, select
Auto Answer from CallControl's right-click menu.

When a checkmark appears next to the Auto Answer command it is
enabled.

Exiting CallControl
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You can close the CallControl program by right-clicking on the CallControl
icon and selecting Exit. This closes the CallControl program until you reboot
the PC or reload the CallControl program by clicking on the CallControl
icon in the FaxTalk Communicator program group.

Note: Closing CallControl prevents FaxTalk Communicator
from answering the phone.
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Chapter 4

FaxTalk Communicator

FaxTalk Communicator is an integrated answering machine and hands-free
speakerphone application. FaxTalk Communicator operates much as a
standard speakerphone would except that it adds the power of full duplex
support for crystal clear conversations. Advanced phone options include
Mute, Hold (with optional music), Speed Dial numbers, and Last 20
Number redial. The LCD displays incoming (with Caller ID) and outgoing
phone numbers, time and date, and a call timer. To load FaxTalk
Communicator, click the Windows Start button, select Programs, FaxTalk
Communicator 4.0 and click the FaxTalk Communicator 4.0 icon. The
FaxTalk Communicator application appears.

Figure 4-1  FaxTalk Communicator Application

The integrated voice messaging provides an easy to use interface for
reviewing received messages and faxes. The voice messaging functions
include support for single or multiple mailboxes with password protection,
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fax on demand, Caller ID, distinctive ring, customized greetings and
mailbox settings with an ultra-flexible configuration.

Full send and receive fax functions include support for Error Correction
Mode (ECM) faxing, advanced 2-D imaging, Binary File Transfer (BFT),
broadcast fax, delayed send, and polling.

Note: Music on Hold is requires modem hardware support.
Caller ID requires service from your phone company.

FaxTalk Communicator toolbar

The FaxTalk Communicator toolbar contains buttons for commonly used
operations. These include:

• Sending a fax

• Manually receiving faxes

• Cancelling a call

• Viewing the Send Log and phonebook

• Configuring the software

To enable the toolbar click Button Bar from the View menu. The toolbar
appears below the menu commands.

Figure 4-2  FaxTalk Communicator toolbar

You can select between large and small icons on the toolbar by using the
Large Buttons command from the View menu

FaxTalk Communicator LCD display

FaxTalk Communicator’s LCD displays various messages and information
depending on the current operation. The current time and date is always
displayed in the upper right hand corner and the status of the software is
always displayed in the lower left hand corner.

Figure 4-3  FaxTalk Communicator LCD Display
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Checking for new messages and faxes

There are two locations where the status of new messages and faxes can
be found, either on FaxTalk Communicator's LCD display or on the FaxTalk
Status screen accessed from CallControl. The LCD displays the number of
messages and faxes in the center of the LCD when FaxTalk Communicator
is idle. The FaxTalk Status screen displays the number of new messages and
faxes near the top of the screen below the Status for: listing.

Enabling auto answer

You can enable and disable FaxTalk Communicator's ability to automatically
answer all incoming calls directly from the FaxTalk Communicator
application. To enable or disable auto answer, select Auto Answer from the
Configure menu.

Using Caller ID

FaxTalk Communicator will display Caller ID if Caller ID information is
available and supplied to the software by the modem. FaxTalk
Communicator displays Caller ID in multiple areas of the software:

• When FaxTalk Communicator is used to accept incoming calls and
Caller ID information is available, the LCD displays the Caller ID in the
lower left hand corner.

• When calls are answered by the voice messaging system and Caller ID
information is available, the Caller ID is logged in the Inbox under the
From field. This occurs regardless of whether the caller has left a
message.

Note: Caller ID requires service from your phone company.

Manually receiving a fax

You can receive a fax manually if you pick up the phone and realize it is a
fax machine calling instead of a live call, or if someone wants to send you a
fax at the end of a voice conversation.

To manually receive a fax, click the Receive Fax Now button on the FaxTalk
Communicator toolbar.

Note: While using the speakerphone, FaxTalk
Communicator can automatically begin receiving faxes as
soon as FaxTalk Communicator "hears" fax tones.
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The Inbox

The Inbox is the central location for all received voice messages, fax
documents, and BFT files. The Inbox contains options and commands for
playing voice messages, viewing fax documents, and saving BFT files. To
open the Inbox, click on the Inbox button on FaxTalk Communicator. The
Inbox appears.

Figure 4-4  FaxTalk Communicator Inbox

Information related to an item is displayed in the From, Type, Date, and
Length fields when an item is received. The Type field contains information
regarding whether the item is a voice, fax, or data (BFT). The Date field
contains the date and time the item was received, The From and Length
fields contain different information depending on the type of item received.

Selecting a mailbox

The Inbox displays all received items for the selected mailbox, or can display
all received items in every mailbox.

To open a specific mailbox:

1. Click Inbox in FaxTalk Communicator.

2. Select the desired mailbox from the mailbox list.

3. Enter the mailbox password, if necessary.

The Inbox displays the contents of the selected mailbox.
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Viewing items in a specific mailbox

Select the desired mailbox from the Mailbox list. If the mailbox is password
protected, you will be prompted to enter the mailbox password before the
Inbox displays the contents of the mailbox.

Viewing items in all mailboxes

Select the All Mailboxes selection from the Mailbox list. If the Mailbox
Manager password was entered in the Mailbox Configuration, you will be
prompted to enter the Mailbox Manager password before the Inbox
displays the contents of all the mailboxes.

Playing messages

The Inbox contains several buttons specifically for playing received
messages. The player buttons are designed to mimic buttons found on a
standard tape player or VCR. The buttons perform the functions of Play,
Stop, Previous Message (Skip Back), and Next Message (Skip Forward). The
Inbox also contains a message scroll bar that will indicate the relative
position in a message during playback. You can use the scroll bar to fast
forward and rewind within a message during playback.

To play a message in the Inbox, double-click on the voice message to begin
playback. You can also highlight the voice message and click Play on the
player controls. To stop playback of a voice message, click Stop. To go back
to the previous message click Previous on the player controls. To skip to the
next message, click Forward.

Setting the playback device

When playing messages from the Inbox you can select the device used for
playback. The list of available playback devices is dependent on the modem
selected. If a playback device option is not listed, it is because the modem
or PC hardware does not support the playback mode.

To set the playback device:

1. From the Messages menu, click Play To.

2. Select the device from the list. A checkmark appears next to the
selected device.

Using message autoplay

The Inbox includes the ability to play all messages automatically when you
log into a mailbox. This functionality is similar to pressing a single play



40

button on an answering machine. To enable the AutoPlay option select
AutoPlay from the Messages menu. A checkmark appears next to Autoplay
when enabled.

Viewing faxes

You can view received faxes viewed using the Fax Viewer that is included
with FaxTalk Communicator. To view a fax, double-click on the fax
document to open the document in the Fax Viewer. You can also highlight
the fax document and click View.

Printing faxes

You can print received faxes directly from the Inbox. To print a fax, select
the fax and click Print.

Binary files

Data items are Binary File Transfer (BFT) received files. FaxTalk
Communicator transmits BFT files using the ITU T.434 BFT international
standard. This allows BFT transfers between FaxTalk Communicator and any
other software package that supports the international standard for
transmitting and receiving BFT files.

To save a received BFT file:

1. Double-click on the BFT file in the Inbox. The Save As dialog appears
with the original filename.

2. Select the directory you want the file saved to, and click OK.

Forwarding items

You can send received items to other Voice/fax mailboxes in your system.
For example, if you receive a message that you would like a colleague to
hear, you can forward it to his or her mailbox.

To forward an item to a Voice/fax mailbox:

1. Select the item(s) to forward to the other mailbox(es)

2. Choose Forward Item from the File menu. The Forward Received Faxes
and Messages dialog appears.
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Figure 4-5  Forward Received Faxes and Messages Screen

3. Select the mailbox(es) you wish to forward the item(s) to.

4. Select whether to forward a copy of the items or to have the items
moved to the selected mailbox(es).

Changing the status of items

New items in the Inbox are displayed in Bold type until they are reviewed by
the mailbox owner. The status of an item can be changed at any time. The
message status can be either “New” or “Old”.

To change the status of a received item:

1. Select the item in the Inbox

2. Choose Set as New on the File menu to change the status of an old
item or Set as Old to change the status of a new item.

Deleting items

Because items in your Inbox consume disk space, you should delete items
that you no longer need. For example, you might want to delete new
messages immediately after listening to them.

To delete items:

1. Select the item(s) in the Inbox.

2. Press the Delete key on the keyboard.

3. Click OK to confirm the deletion of the messages.

Note: If you press the Delete key on the keyboard with
nothing selected in the Inbox, the entire Inbox is deleted.
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Saving items

Items in the Inbox can be saved for use elsewhere. Received voice
messages are stored in a .WAV format, and can be saved from the Inbox
and played with a wave file player. Received faxes and BFT file can also be
saved. To save a received item, highlight the item in the Inbox and select
Save As from the File menu.

The Outbox

Faxes are listed in the Outbox until they are successfully sent or have failed
the maximum number of retries. The Outbox displays the name of the
recipient, the number the fax is being sent to, the time and date the fax
will be sent, and the number of pages in the fax. Once a fax has been
successfully sent or has failed the maximum number of retries, it is removed
from the Outbox and placed in the Send Log. To view the Outbox, click the
Outbox button on FaxTalk Communicator. The Outbox appears.

Figure 4-6  FaxTalk Communicator Outbox Screen

Editing a scheduled fax

You can edit the properties of a scheduled fax in the Outbox by
highlighting the fax and clicking Properties. The Send Properties dialog
displays with the current properties of the scheduled fax. You can modify
the properties and click Send to resubmit the fax for sending using the new
properties.

Placing a scheduled fax on hold

You can place a scheduled fax on hold so that it is not sent until you
release the fax from hold. The On Hold command is useful for laptop users
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who may not have immediate access to a phone line, but still want to
schedule a fax for sending. By scheduling a fax and placing it on hold, the
fax is listed in the Outbox but is not sent until the user releases the fax.

Releasing a fax from hold

You can release faxes that are on hold at any time from the Outbox. To
release a fax that has a status of On Hold, highlight the fax and select
Resume from the Send menu.

Deleting scheduled faxes

You can delete a scheduled fax or faxes from the Outbox by highlighting
the specific fax(es) and clicking Delete.

The Send Log

The Send Log contains information about faxes that have been sent,
whether successful or not, from FaxTalk Communicator. You can use the
Send Log to track the status of faxes that were sent, view a sent fax, print
hard copy records of transactions, as well as resend faxes if necessary. To
view the Send Log, click the Send Log button on the FaxTalk
Communicator toolbar. The Send Log appears.

Figure 4-7  FaxTalk Communicator Send Log Screen

Viewing sent faxes

You can view a previously sent fax stored in the Send Log by highlighting
on the fax and clicking View. If there are multiple documents attached to
the fax, a View Fax Document dialog appears to allow you to select the
specific fax document you wish to view.
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Printing sent faxes

You can print a previously sent fax stored in the Send Log by highlighting
the fax and clicking Print.

Resending a sent fax

You can resend faxes from the Send Log. The information from the
previous fax is stored in the Send Log and is available for retransmission.
This is useful if you sent a fax that got lost and need to send it again.

To resend a fax:

1. Highlight the fax you wish to resend and click Resend. The Send a Fax
dialog appears with the previous fax information.

2. Make any changes to the fax and click Send.

Printing the Send Log

To print a hard copy of the Send Log, select Print from the Log menu.

Deleting entries

To delete an entry in the Send Log, highlight the fax entry and click Delete.
Once entries are deleted from the Send Log, they are permanently deleted
from the hard disk and there is no method to restore the deleted entries.

Checking the status of the software

You can monitor the status of the software at any time from one of several
locations. Status information is available from the LCD display on FaxTalk
Communicator, the CallControl icon, or from the FaxTalk Status screen.
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Chapter 5

Using the Speakerphone

With the FaxTalk Communicator speakerphone you can place and receive
voice calls and use your computer and modem as a "smart" telephone.
FaxTalk Communicator's speakerphone capabilities offer mute, hold with
optional music, last 20 number redial, and support for call waiting services.

Note: Not all options are available with all modems.
Speakerphone capabilities are a feature of the modem and
require specific modem hardware support to function. The
software cannot "add" speakerphone capabilities to a
modem that does not have hardware support for
speakerphone.

Figure 5-1  FaxTalk Communicator Application
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Receiving calls

To answer an incoming call on FaxTalk Communicator's speakerphone, click
Speaker. The speakerphone answers the call and connects you to the
calling party. When you're finished with the call, click Hangup.

Placing calls

You can place outgoing calls with FaxTalk Communicator using a variety of
methods:

• If the number you wish to call is entered in the phonebook, click the
Phonebook tab and either double-click on the entry or highlight the
entry and click Dial.

• If you previously added a number to a Speed Dial button, click the
Speed Dial tab and click on the appropriate button.

• Click Speaker to take the phone off-hook and enter the numbers
individually

• Select a previously dialed number from the Redial list, and click Dial.

Using speed dial buttons

The Speed Dial tab contains 8 speed dial buttons that can be configured
with frequently dialed numbers. To dial a number using speed dial, click the
desired button.

To configure a Speed Dial button see Configuring Speed Dial buttons later
in this chapter.

Using the phonebook

The Phonebook tab displays all entries in the FaxTalk Phonebook. You can
dial a phonebook entry by either double clicking on the entry or
highlighting the entry in the Name column and clicking Dial. When a
phonebook entry is highlighted, the number to be dialed is displayed in the
Redial field.

Using the redial list

FaxTalk Communicator includes a recent dialed numbers list that contains
the last 20 numbers dialed. To redial a number in the redial list, select the
number from the dropdown list and click Dial.
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Placing callers on hold

During a conversation on the speakerphone, you can put callers on hold by
clicking Hold. When hold is active, a green light appears on the Hold
button. To take a caller off hold, click Hold again. FaxTalk Communicator
includes the ability to play .WAV, MIDI, or CD-Audio music to the caller
while on hold. This feature requires specific modem support and may not
be available. To configure music on hold see Configuring Music on Hold
later in this chapter.

Muting a conversion

To mute a call so that the caller cannot hear conversations occurring locally,
click Mute. When Mute is active a green light appears on the Mute button.
Click on Mute again to resume a normal conversation.

Using the speakerphone with call waiting

If you subscribe to "call waiting" service through your phone company, you
can continue receiving calls while talking on the speakerphone. When a
new call comes in and your phone company sends a tone to indicate
another call, click Flash to put the current call on "standby" and switch to
the new call. When finished with the second call, click Flash again to
switch back to the original call.

Adjusting the speakerphone volume

The Speaker volume control allows you to adjust the volume of the caller
while on the speakerphone. If you want to increase the volume of the
caller's voice, slide the volume control to the right. To decrease the caller's
volume, slide the volume control to the left.

Adjusting the microphone sensitivity

The Microphone sensitivity control allows you to adjust the sensitivity of the
microphone when used with the speakerphone. If you want to increase the
sensitivity of the speakerphone microphone, slide the volume control to the
right. To decrease the sensitivity of the speakerphone microphone, slide the
volume control to the left.
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Configuring music on hold

If the modem selected for use with FaxTalk Communicator supports music
on hold capabilities, the Configure Menu contains a Music on Hold
command. To configure music on hold, select Music on Hold from the
Configure menu. The Music on Hold Configuration dialog appears.

Figure 5-2  Music on Hold Setup Screen

To configure music on hold:

1. Enable Music on Hold by checking the Play Music on Hold command.

2. Select the device you want to use for Music on Hold. You can use a
Multimedia or Line In device depending on hardware available in your
computer.

3. Select the music sequence you want music on hold to play when
activating the hold button. Using Continue sequence between calls
causes music on hold to play the next available sound file each time
the hold is toggled on and off. The Restart sequence each call option
causes music on hold to replay the current sound file from the
beginning each time the hold button is toggled.

Adding files

You can add, remove, or rearrange the sound files used for music on hold
in the Play List tab. The Play List supports several music or sound file types
including .WAV, .MID (Midi), and .CDA (CD-Audio).
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To add music files to the music on hold play list:

1. Click the Play List tab. The Play List appears.

Figure 5-3  Music on Hold Play List

2. Click Add. An Open dialog appears to select sound files on your
computer.

3. Click Test to test the playback of the sound files to your multimedia
device.

Removing files

To delete sound files from the music on hold play list, highlight the sound
files you wish to delete and click Remove.

Rearranging the play list

You can rearrange the order in which the sound files are played to the
caller while they are on hold. Use the Up and Down buttons to move
highlighted sound files on the play list.
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Configuring speed dial buttons

The Speed Dial Configuration is used to assign names and numbers to the
speed dial buttons available with FaxTalk Communicator. You can store up
to eight names and numbers using the speed dial buttons. To configure the
speed dial buttons, select Speed Dial from the Configure menu. The
Configure Speed Dial Buttons dialog appears.

Figure 5-4  Speed Dial Button Setup Screen

Adding speed dial entries

You can manually add names and numbers into speed dial buttons or select
existing names from the FaxTalk Phonebook.

To add a name and number to a speed dial button:

1. Select the speed dial button to add or modify from the Select Button
dropdown.

2. Enter the name to be displayed on the speed dial button in the name
field or double-click on a name already entered in the phonebook.

3. Enter the number to be dialed when the speed dial button is pressed in
the number field.

4. Click OK to save the changes to the speed dial button.
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Chapter 6

Remote Access

FaxTalk Communicator's voice messaging capabilities include a powerful
remote access option. With remote access you can remotely retrieve your
messages and faxes, change your mailbox greeting and other system
options.

Listening to your Messages

FaxTalk Communicator includes the ability to retrieve received messages
remotely. To listen to received messages remotely:

1. Call FaxTalk Communicator, enter the desired mailbox number and
press #.

2. While the greeting is played for that mailbox, press # again.

3. FaxTalk Communicator now asks for the mailbox password. Enter the
password and press # (If you do not have a password assigned, simply
press #).

4. FaxTalk Communicator now indicates the number of new messages
and faxes and presents the main menu.

5. Press 1 to listen to messages. (This option is not available if there are
no new messages).

6. The Messages menu plays the options available. Press 1 to listen to the
current message. To skip to the next message press 5 or to go back to
the previous message press 6.

7. After listening to the message press 1 to delete the message, press 3 to
replay the message, press 5 to skip to the next message, or press 6 to
go back to the previous message.

8. To return to the main menu, press #. To exit the remote access system,
press # and hang up.

Reviewing your Faxes

FaxTalk Communicator includes the ability to review received faxes
remotely and have them forwarded to a fax machine.
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To review received faxes remotely:

1. Call FaxTalk Communicator, enter the desired mailbox number and
press #.

2. While the greeting is played for that mailbox, press # again.

3. FaxTalk Communicator now asks for the mailbox password. Enter the
password and press # (If you do not have a password assigned, simply
press #).

4. FaxTalk Communicator now indicates the number of new messages
and faxes and presentS the main menu.

5. Press 2 to review received faxes. (This option will not be available if
there are no new faxes).

6. The Review Faxes menu plays the option to press 1 to forward all faxes
or press 2 to forward individual faxes.

7. To return to the main menu, press #. To exit the remote access system,
press # and hang up.

Forwarding All Faxes

1. Press 1 to forward all faxes immediately on the same call (If calling
from a phone connected to a fax machine) or press 2 to enter a fax
number to forward to.

2. If option 2 was selected, enter the fax number of the fax machine the
faxes are to be sent to and press #.

3. The fax number is read back to verify. Press 1 to accept, press 2 to re-
enter the number, or press # to cancel the forwarding operation.

Forwarding Individual Faxes

1. Press 1 to select this fax for forwarding, or press 2 to skip to the next
fax without selecting this fax for forwarding.

2. Press # when finished selecting faxes.

3. Press 1 to forward all faxes immediately on the same call (If calling
from a phone connected to a fax machine), or press 2 to enter a fax
number to forward to.

4. If option 2 was selected, enter the fax number of the fax machine the
faxes are to be sent to and press #.

5. The fax number will be read back to verify. Press 1 to accept, press 2 to
re-enter the number or press # to cancel the forwarding operation.
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Changing the Mailbox Greeting

FaxTalk Communicator includes the ability to change the selected greeting
of a mailbox remotely.

To record a new greeting for a mailbox remotely:

1. Call FaxTalk Communicator, enter the mailbox desired and press #.

2. While the greeting is played for that mailbox, press # again.

3. FaxTalk Communicator asks for the mailbox password. Enter the
password and press # (If you do not have a password assigned, simply
press #).

4. FaxTalk Communicator now indicates the number of new messages
and faxes and presents the main menu.

5. Press 3 to change greeting.

6. The Change Greeting menu plays the option to press 1 to listen to the
current greeting, or press 2 to record a new greeting.

7. After recording a new greeting, press 1 to listen to the new greeting,
press 2 to re-record the greeting, or press 3 to activate the new
greeting. Press # to cancel the new greeting and use the old greeting.

8. To return to the main menu, press #. To exit the remote access system,
press # and hang up.

Changing Configuration Options

FaxTalk Communicator includes the ability to change certain system
configuration settings remotely such as number of rings, toll saver, and
notification options.

To change system configuration settings:

1. Call FaxTalk Communicator, enter the mailbox desired and press #.

2. While the greeting is played for that mailbox, press # again.

3. FaxTalk Communicator asks for the mailbox password. Enter the
password and press # (If you do not have a password assigned, simply
press #).

4. FaxTalk Communicator now indicates the number of new messages
and faxes and presents the main menu.

5. Press 4 to change options.
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6. The Change Options menu plays the option to press 1 to change
number of rings, press 2 to change toll saver, 3 to change voice
notification options, or press 4 to change pager notification settings.

7. To return to the main menu, press #. To exit the remote access system,
press # and hang up.

Remote Access Menu Diagram

This chart outlines all of the remote access functions and commands.
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Chapter 7

Sending Faxes

When sending faxes with FaxTalk Communicator, you can choose between
two interfaces. One interface is the Fax Wizard which guides you step by
step through the process of sending a fax. The other interface is the Send a
Fax dialog which provides more advanced fax sending options and settings.

When you install FaxTalk Communicator, the Fax Wizard is the default
interface used when sending faxes. If you prefer to use the Send a Fax
dialog , you can switch to the Send a Fax dialog by clicking the Advanced
Fax button on the Fax Wizard. You can also configure the software to use
the Send a Fax dialog as the default interface. (See Disabling the Fax
Wizard later in this chapter)

Sending faxes from FaxTalk Communicator

You can send faxes directly from FaxTalk Communicator or from
CallControl. Both the FaxTalk Communicator and CallControl applications
include a Send Fax command.  When you select the Send Fax command
either the Fax Wizard or Send a Fax dialog appears depending on the
settings. You can then specify your recipients, coversheet information, and
other information.

Sending faxes from Windows applications

Sending a fax from any Windows application is as simple as printing a
document. When you install FaxTalk Communicator, a printer named
FaxTalk 4.0 is added to the list of printers installed under Windows. When
you want to fax a document from a Windows application, simply select the
FaxTalk 4.0 printer from the Windows application's print menu and print
the document. FaxTalk Communicator then presents options for selecting
recipients, adding a coversheet, and scheduling the fax. FaxTalk
Communicator converts the document into a fax and sends it in the
background, allowing you to continue to work on other tasks.
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To send a fax from a Windows application:

1. Select FaxTalk 4.0 as the current print driver from the Windows
application's Print Setup dialog box.

2. Choose the Print command. The Windows Print dialog box appears.
Make sure the FaxTalk 4.0 printer driver is selected and click OK.

3. Enter recipient information, attach a coversheet if desired, and set
scheduling options.

Sending faxes from Windows Explorer

You can send faxes directly from the Windows Explorer. Highlight the
document you wish to send in Explorer and click the right mouse button.
Select FaxTalk Recipient from the Send To menu. FaxTalk Communicator
then presents options for sending the fax.

Using the Fax Wizard

The Fax Wizard makes sending faxes easy. The Fax Wizard guides you
through the process of sending a fax in four simple steps. The Fax Wizard is
broken down into: Selecting Recipients, Select a Coversheet, Attaching
Files, and Scheduling the Fax.

The Fax Wizard appears whenever you print to the FaxTalk 4.0 printer or
click the Send Fax command from FaxTalk Communicator or CallControl, if
the Use Fax Wizard when Sending Faxes option is enabled on the Fax tab in
FaxTalk Program Configuration.

Selecting recipients

The Select Recipients page of the Fax Wizard is used to enter the recipients
you wish to send the fax to. The only information required to be entered to
send a fax is the Fax # field. When sending a fax using the Fax Wizard, the
Select Recipients screen appears.
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Figure 7-1  Fax Wizard Select Recipients Screen

When you are finished entering the recipient information click Next to
continue with the Fax Wizard.

Entering recipients manually

If you are sending a one time fax to a recipient, simply enter the recipient
information in the Name and Fax Number fields and click Next.

Selecting recipients from the phonebook

To select recipients from the phonebook, click Phonebook and highlight the
recipient(s) you wish to send to and click OK. The selected recipients are
added to the recipient list.

Sending a fax to multiple recipients

You can send a fax to multiple people by adding them to the Recipient List.
To add any recipient to the list, simply enter the desired recipient
information in the Fax # (required), First Name, Last Name, and Company
fields and click Add to Recipient List, or select the entries in the phonebook
and click OK. If a coversheet is attached to the fax, each recipient gets a
personalized copy with only their information. To remove a recipient from
the list, highlight the recipient and click Remove.
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Selecting a coversheet

The Select a Coversheet page of the Fax Wizard is used to add a
coversheet to the fax and fill in a short memo on the coversheet. After
clicking Next on the Select Recipients screen the Select Coversheet screen
appears.

Figure 7-2  Fax Wizard Select Coversheet Screen

When you are finished entering the coversheet information click Next to
continue with the Fax Wizard.

Previewing the coversheet

You can preview the current coversheet before it is sent by clicking Preview.
The Coversheet will be loaded into the Fax Viewer and displayed so that
you can see how it would look when you send it.

Note: When previewing a coversheet the recipient
information appears blank. This is because the recipient
information is not added to the coversheet until the fax is
actually sent.

Adding files to the fax

The Attaching Files page of the Fax Wizard is used to add files to the fax.
You can attach any type of document that can be printed by an
application, and FaxTalk will handle the conversion of the document



Chapter 7 - Sending Faxes 59

automatically in the background. After clicking Next on the Select
Coversheet screen, the Attach Files screen displays.

Figure 7-3  Fax Wizard Add Files Screen

When you are finished adding files to the fax or do not wish to attach files,
click Next to continue with the Fax Wizard.

Scheduling the fax

The Scheduling the Fax page of the Fax Wizard is used to select when you
would like to send this fax. The default setting is to send the fax
immediately. After clicking Next on the Attach Files screen, the Schedule
the fax screen appears.



60

Figure 7-4  Fax Wizard Schedule Fax Screen

When you have selected when you would like to send the fax, click Finish
or Send to send the fax and exit the Fax Wizard.

Manually sending a fax

Normally, FaxTalk Communicator automatically dials the recipient fax
number when it sends the fax for you. In some cases, you might need to
dial the number manually. For example, you must use manual dialing to
send a fax to a machine that is accessed through an operator or voice mail
system. You can also use manual dialing to send a fax to someone to
whom you are already speaking with.

To send a fax manually:

1. Create the fax and attach a coversheet and additional files if desired.

2. Select the I want to send this fax by manually dialing the fax number
setting from the Schedule screen. Click Send to create the fax.

3. When FaxTalk Communicator prompts you to dial the number, dial the
recipients fax number using a telephone connected to the modem.

4. When the recipient's fax machine answers, click OK on the Manual
Dial dialog.

5. Wait for your modem to begin sending fax tones, and then hang up
the telephone.
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Disabling the Fax Wizard

You can disable the use of the Fax Wizard when sending faxes. FaxTalk
Communicator will then use the Send a Fax dialog instead of the Fax
Wizard when sending faxes.

To disable the Fax Wizard:

1. Click on the Program Configuration button on the FaxTalk
Communicator toolbar.

2. Click the Fax tab.

3. Uncheck the Use Fax Wizard when Sending Faxes box.

4. Click OK to save the change.

Using the Send a Fax dialog

The Send a Fax dialog is the preferred method for sending faxes for
advanced users, since it includes advanced fax options not found in the Fax
Wizard. The Send a Fax dialog is divided into four tabs: Recipients,
Coversheet, Attach Files, and Schedule Fax. To send a fax, you do not need
to go to each tab unless there are options on that tab that you want to
modify. You can send a fax by simply entering the fax number and clicking
the Send button. The Send a Fax dialog also includes the ability to print a
document into a fax document for storage using the File It button.

You can jump to the Send a Fax dialog from the Fax Wizard by clicking
Advanced Fax on the Select Recipients screen in the Fax Wizard.

Note: To use the Send a Fax dialog by default, disable the
Use Fax Wizard when Sending Faxes option on the Fax tab
in FaxTalk Program Configuration.

Recipient tab

The Recipient tab in the Send a Fax dialog contains all of the addressing
information when sending a fax. The only information required to be
entered to send a fax is the Fax # field.
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Figure 7-5  Send a Fax Recipients Tab

Entering recipients manually

If you are sending a one time fax to a recipient, simply enter the recipient
information in the Name and Fax Number fields.

Selecting recipients from the phonebook

To select recipients from the phonebook, click Phonebook, highlight the
recipient(s) you wish to send to, and click OK. The selected recipients are
added to the recipient list.

Sending a fax to multiple recipients

You can send a fax to multiple people by adding them to the Recipient List.
To add any recipient to the list, simply enter the desired recipient
information in the Fax # (required), First Name, Last Name, and Company
fields, and click Add to Recipient List or select the entries in the phonebook
and click OK. If a coversheet is attached to the fax, each recipient will get a
personalized copy with only their information. To remove a recipient from
the list, highlight the recipient and click Remove.

Coversheet tab

This enables the attachment of a coversheet to a fax document or enables
sending of just a coversheet with a memo. If multiple recipients are
selected in the Recipient tab then a separate, personalized coversheet is
created for each recipient. To attach a coversheet or make changes, click
the Coversheet tab. The Coversheet settings display.
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Figure 7-6  Send a Fax Coversheet Tab

Previewing the coversheet

You can preview the current coversheet before it is sent by clicking Preview.
The Coversheet is loaded into the Fax Viewer and displayed so that you can
see how it would look when you send it.

Note: When previewing a coversheet the recipient
information appears blank. This is because the recipient
information is not added to the coversheet until the fax is
actually sent.

Attach tab

The Attach Files tab in the Send a Fax dialog allows you to attach
documents to be sent as a fax or BFT file. You can attach any type of
document that can be printed by an application, and FaxTalk handles the
conversion of the document automatically in the background. The Attach
Files tab also allows you to attach previously saved faxes that are stored in
the File Cabinet. To attach files to a fax, click the Attached Files tab. The
Attached Files settings display.
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Figure 7-7  Send a Fax Attach Files Tab

Changing attached file options

The File Options dialog lets you change options related to creating the fax
such as resolution, page size, and orientation. To change the options of an
attached file, highlight the file and click Options.

Sending a file using Binary File Transfer

FaxTalk Communicator supports sending files as Binary File Transfer data
files. This allows you to send a binary file to someone if they are using ITU/
TSS T.434 compliant software or hardware.

To send the file using Binary File Transfer:

1. In the Attached Files list, highlight the file you want to send as a data
file.

2. Click Options, and select Data File from the Send File As list.

3. Click OK to set the file as data.

Scheduling the fax

The Schedule Fax tab in the Send a Fax dialog contains options for
determining when you want to send the fax. To schedule a fax, click the
Schedule Fax tab. The Schedule Fax settings displays.
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Figure 7-8  Send a Fax Schedule Fax Tab

The following options are available for scheduling a fax:

• As Soon as Possible — Select this if you want to send the fax
immediately.

• At Date and/or Time — Select this option if you want to schedule a
specific date and/or time for the fax to send. You can set the specific
date and/or time in the adjacent fields.

• Manual Dial — Select this option if you want to manually dial the fax
number on a local telephone directly attached to the modem.

• Place Fax "On Hold" — Select this option if you want to schedule the
fax to be stored in the Outbox until you release it for sending.

Manually sending a fax

Normally, FaxTalk Communicator automatically dials the recipient fax
number when it sends the fax for you. In some cases, you might need to
dial the number manually. For example, you must use manual dialing to
send a fax to a machine that is accessed through an operator or voice mail
system. You can also use manual dialing to send a fax to someone to
whom you are already speaking with.
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To send a fax manually:

1. Create the fax and attach a coversheet and additional files if desired.

2. Select Manual Dial on the Schedule Fax tab. Click Send to create the
fax.

3. When FaxTalk Communicator prompts you to dial the number, dial the
recipients fax number using a telephone connected to the modem.

4. When the recipient's fax machine answers, click OK on the Manual
Dial dialog.

5. Wait for your modem to begin sending fax tones and then hang up the
telephone.

Polling a remote fax machine

FaxTalk Communicator includes the ability to poll a fax machine for any
available documents. Polling allows you to call a fax machine and receive
any documents the fax machine's owner programmed to be polled. To poll
a fax machine, check the Poll Recipient box on the Schedule Fax tab.

Saving a document in fax format

The Send a Fax dialog includes the ability to print a document from an
application and save it in fax format for later use using the File It button.
This is convenient when you have a datasheet or sales brochure that you
send out often, and do not want to load the application that created the
document and print every time you want to send the fax.

To save a document in fax format:

1. Open the document in the application that it was created in, and print
the document to the FaxTalk 4.0 printer.

2. When the Send a Fax dialog appears, click File It. If the Fax Wizard
appears instead of the Send a Fax dialog, click Advanced Fax to switch
to the Send a fax dialog. Then click File It.

3. The File It As dialog appears. Enter the desired name for the saved fax
document and click Save.

The fax document is then created and stored in the File Cabinet directory
for later use.
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Sending a fax during a voice call

If you are talking on a telephone handset attached to your modem, it is
possible to send a fax at the end of the call. To send a fax at the end of a
voice call, click on the Send a Fax button on FaxTalk Communicator's
toolbar. Either the Fax Wizard or the Send a Fax dialog appears.

If the Fax Wizard appears:

1. Click Next on the Select Recipients screen. (Do not fill out any recipient
information for this fax).

2. To send a coversheet with this fax, check the "I want to send a
coversheet" option, and select a coversheet from the list. Use the
Memo field to include a short memo on the coversheet, and click Next.

3. If you want to attach files to the fax, use Add to attach the desired files
to the Attached Files list and click Next.

4. Select the option "I want to send this fax by manually dialing the fax
number" and click Send. FaxTalk then creates the fax and prompts you
to click OK when the recipient is ready to receive the fax.

5. Tell the recipient to begin receiving with their fax machine, and then
click OK on the Manual Dial dialog.

6. You can now hang up the phone, and the fax is sent.

If the Send a Fax dialog appears instead of the Fax Wizard:

1. Click the Coversheet tab to attach a coversheet to the fax.

2. Click the Attached Files tab to add files to the fax.

3. Click the Schedule tab, select the Manual Dial option in the Schedule
section, and click Send. FaxTalk then creates the fax, and prompts you
to click OK when the recipient is ready to receive the fax.

4. Tell the recipient to begin receiving on their fax machine, and then click
OK on the Manual Dial dialog.

5. You can now hang up the phone, and the fax is sent.
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Viewing scheduled faxes

Faxes are listed in the Outbox until they are successfully sent or have failed
the maximum number of retries. The Outbox displays the name of the
recipient, the number the fax is being sent to, the time and date the fax
will be sent, and the number of pages in the fax.

To display the contents of the Outbox, click Outbox on FaxTalk
Communicator.

Editing a scheduled fax

You can edit the properties of a scheduled fax in the Outbox by
highlighting the fax and clicking Properties. The Send Properties dialog is
displayed with the current properties of the scheduled fax. You can modify
the properties and click Send to resubmit the fax for sending using the new
properties.

Displaying fax status

You can monitor the status of faxes you are sending or receiving using
either the FaxTalk Status screen or the program status line in the LCD
display on FaxTalk Communicator. The FaxTalk Status screen provides
detailed status information for the current fax. You can have the FaxTalk
Status screen automatically appear when sending or receiving faxes.

To have FaxTalk Status automatically appear during fax transactions:

1. From FaxTalk Communicator, click the Program Configuration button
on the toolbar.

2. Click on the Announce tab.

3. Check the Enable the Pop up FaxTalk Status while sending or receiving
faxes box.

4. Click OK to save the change and exit Program Configuration.

Canceling a fax

If you have a scheduled fax you wish to delete, or a fax that is being sent
that you want to cancel, simply highlight the entry in the Outbox and click
Delete. This deletes the fax from the Outbox.

If you want to simply abort the current send attempt without deleting the
fax from the Outbox, click Hangup on the FaxTalk Status screen or the
Cancel Call button on FaxTalk Communicator's toolbar.
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Resending a previously sent fax

You can resend faxes from the Send Log. The information from the
previous fax is stored in the Send Log and is available for retransmission.
This is useful if you sent a fax that was lost and need to resend it again.

To resend a fax:

1. From FaxTalk Communicator toolbar, click the Send Log button.

2. Highlight the fax you wish to resend and click Resend. The Send a Fax
dialog appears with the previous fax information.

3. Make any changes to the fax and click Send.

Creating coversheet logos

FaxTalk Communicator includes several coversheet logos when you install
the software. FaxTalk Communicator lets you create coversheet logos to be
used at the top of coversheets that you send. You may want to create
several coversheet logos to use depending on the intended recipient.

Note: Logo files should be no more than 3" high by 8 3/8"
wide, and saved at 200 dpi. When designing the logo, a
.3" space at the top must be left to allow enough room
for the fax header information.
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Chapter 8

Using the Fax Viewer

The Fax Viewer gives you a number of tools for manipulating the fax image
you are viewing. You can use the Fax Viewer to view, print, rearrange, and
edit fax documents. The Fax Viewer includes the ability to use a TWAIN
compliant scanner to scan in documents, to add to an existing fax, or
create a new fax document. To open the Fax Viewer, click the Windows
Start button, select Programs, FaxTalk Communicator 4.0, and click on the
FaxTalk Fax Viewer 4.0 icon. The Fax Viewer opens.

Figure 8-1  Fax Viewer application

Enabling the Fax Viewer toolbar

To enable the Fax Viewer toolbar, select Toolbar from the View menu. The
Fax Viewer toolbar appears below the menu commands.

Figure 8-2  Fax Viewer toolbar
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The Fax Viewer toolbar contains buttons for commonly used operations.
These include:

• Opening files

• Printing

• Changing zoom levels

• Enabling anti-aliasing

• Enabling annotations

You can select between large and small icons on the toolbar by using the
Large Buttons command from the View menu.

Working with Fax Documents

The Fax Viewer enables you to manage your fax documents. From within
the Fax Viewer, you can open fax documents for printing, saving, importing
and exporting. You can also add, rearrange, and delete individual pages in
a fax document.

Opening fax documents

To open a fax file in the Fax Viewer, select Open from the File menu. The
File Open dialog displays. Select the fax filename and click OK.

Printing a fax document

To print a fax file in the Fax Viewer, select Print from the File menu. The
Print dialog displays. Click OK to print the document to the selected printer.

Saving fax documents

To save a fax file in the Fax Viewer, select Save As from the File menu. The
Save As dialog displays. Type in the filename you wish to save the fax file
and click OK.

Importing files into a fax document

To import .BMP or .PCX graphic files into a fax document, select Import
from the File menu. The File Open dialog displays. Select the .PCX or .BMP
file to import and click OK.

To import pages from a fax document into another fax document, select
Import from the File menu. The File Open dialog displays. Select the .FAX
file to import and click OK.
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Exporting a fax document

To export a fax to a graphic file, select Export from the File menu. The File
Export dialog appears.

Figure 8-3  File Export

If the fax document consists of multiple pages you have the option of
exporting the whole document to a fax file or selecting individual pages to
export to a graphic file such as a .BMP or .PCX file.

Deleting pages in a fax document

To delete a page from a fax document, select the fax page and click Delete
from the Edit menu. To select multiple pages, hold the Ctrl key while
clicking on the fax pages.

Rearranging pages in a fax document

The Fax Viewer includes the ability to rearrange the order of pages in a fax.
You can rearrange pages, delete individual pages, and add additional pages
to an existing fax document.

To rearrange pages in a fax:

1. Select a zoom level that allows you to view the fax pages.

2. Click and hold the left mouse button on the edge of the fax page you
wish to move. The cursor changes to a four arrow pointer.

3. Drag the fax page to the desired location and release the left mouse
button.

Viewing Fax Documents

You can conviently view fax documents in the Fax Viewer using several
tools available, including zoom, thumbnails, anti-aliasing, and more.
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Changing the zoom level

To change the zoom level, click the Zoom In or Zoom Out buttons on the
Fax Viewer toolbar. You can also use custom zoom levels by selecting Zoom
from the View menu and entering the custom zoom level.

Flipping a fax document 180 degrees

To flip a fax document 180 degrees, click Flip from the View menu.

Rotating a fax document 90 degrees

To rotate a fax document 90 degrees to the left or right, click Rotate Left or
Rotate Right from the View menu.

Displaying thumbnails

To display thumbnail versions of the fax document, click the Thumbnail
button on the Fax Viewer toolbar.

Using anti-aliasing

Anti-aliasing is a technique used to improve the visual appearance of a fax
document. To enable anti-aliasing, click the Anti-aliasing button on the Fax
Viewer toolbar.

Using reverse video

To reverse the video display when viewing a fax so that the fax page
appears black and the text appears white, click Reverse Video from the
View menu.

Annotating fax documents

The Fax Viewer includes tools to annotate or markup received faxes with
text and images. This can be useful to add comments to a fax and then
resend the fax back to the original sender.

Enabling the annotation toolbar

The Markup Annotation toolbar contains commonly used tools and
commands for annotating fax documents. These include drawing tools,
formatting options, and graphic and text importers. To enable the Markup
Annotation toolbar, click on the Markup button on the Fax Viewer toolbar.
The Markup Annotation toolbar appears below the Fax Viewer Toolbar.
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Figure 8-4  Annotation Toolbar

Using the annotation tools

The Fax Viewer includes various drawing tools for annotating or marking
up a fax. The tools include functions for drawing lines with and without
arrows, freehand drawing, rectangles, ovals, and polygons.

You can also change the color used by the annotation tools by clicking the
Color button on the annotation tool bar. You can control the fill color,
object color, and line width.

Inserting text objects

You can insert text onto a fax page by selecting the Insert Text tool.

1. Click the Insert Text button on the Markup toolbar. The cursor changes
to a crosshair.

2. Click and hold the left mouse button at the desired starting point.

3. Drag the cursor to the desired end point and release the left mouse
button.

4. Type in the text desired.

Note: To change the text within a text object, simply
double click on the text object to edit. To change to font
and formatting of the text, click the Font button on the
annotation tool bar.

Changing text settings

1. Click the Select button on the Markup toolbar. The cursor changes to
an arrowhead.

2. Select the text object to be modified by clicking the left mouse button
over the text object.

3. Click the Font button on the Markup toolbar. The Font dialog appears.

4. Select the desired font attributes for the text object.

5. Click OK to save the font changes and apply them to the text object.

To change the text within a text object, simply double-click on the text
object to edit.
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Inserting graphic images

You can insert a graphic file onto a fax page such as a .PCX or .BMP file by
using the Insert Bitmap tool.

1. Click the Insert Bitmap button on the Markup toolbar.

2. The Insert Bitmap dialog appears to select the desired image.

3. Select the correct image and click OK.

The picture now appears on the fax page. You can re-position the picture
by clicking the left mouse button with the cursor directly over the image,
and dragging the object to the desired position.

Highlighting objects

You can highlight portions of the fax to emphasize importance by using the
Highlighter tool.

1. Click the Highlighter button on the Markup toolbar. The cursor
changes to an arrowhead.

2. Click and hold the left mouse button at the desired starting point.

3. Drag the cursor to the desired end point, and release the left mouse
button.

The selected text now displays highlighted.

Changing color settings

You can change the colors used for lines and fills when working with
annotation objects. You can also set the default line width used when
drawing shapes.

Figure 8-5  Colors Screen

1. Click the Select button on the Markup toolbar. The cursor changes to
an arrowhead.

2. Select the object to be modified by clicking the left mouse button over
the object.
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3. Click the Colors button on the Markup toolbar. The Colors dialog
appears.

4. Select the desired line color and fill color for the object.

5. Click OK to save the color changes and apply them to the object.

The Colors dialog also allows the line width to be changed. To change the
line width, enter a value between 0 and 200 in the Width field.

Moving an object to the front

When making annotations on a fax, there may be situations where objects
are covered by other objects. To move an object in front of all other
objects:

1. Click on the object to be moved to the front of all other objects.

2. Click the Move to Front button on the Markup toolbar.

3. The selected object now appears in front of all other objects.

Moving an object to the back

When making annotations on a fax there may be situations where objects
are covered by other objects. To move an object behind all other objects:

1. Click on the object to be moved behind all other objects.

2. Click the Move to Back button on the Markup toolbar.

3. The selected object now appears behind all other objects.

Saving annotations to a fax document

Annotations made to a fax are not saved automatically. To save annotations
made to a fax permanently:

1. Select Merge with Image from the Markup menu. The annotations are
then merged on the same layer as the fax document.

2. Select Save from the File menu to save the merged fax.

To undo a merge and remove all annotations from a fax, select Revert to
Saved from the File menu.

Discarding changes made to a fax document

You can discard changes made to a fax file by selecting Revert to Saved
from the File menu. This will return the fax document to the last saved
version.
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Optical Character Recognition (OCR)

Optical Character Recognition (OCR) is a process of turning an image into
editable text. A fax document is an electronic picture of text. Images of text
are not directly editable in an application such as a word processor. OCR is
used to covert a fax document into a text file that can be edited.

The most common use for OCR is when someone needs to modify or fill in
information on a received fax, such as an order form. The received fax is
not in a format that can be read by a word processor so the document
needs to be converted using OCR into a text-based file that can be opened
in a word processor.

Converting a fax document into text

Converting a fax image to text allows the information that was included on
the fax to be edited. To convert a fax image to text:

1. Open the fax document to be converted.

2. Select OCR from the File menu.

3. Enter a filename to save the converted text and click OK. The
conversion of the fax begins.

Note: This feature may not be available when FaxTalk
Communicator is bundled with a modem. If this feature is
unavailable, the modem manufacturer has chosen to not
provide the OCR feature.

Scanning images

The Fax Viewer supports the use of a TWAIN compliant scanner for
importing images into a fax document. For best results, scan documents at
200 dpi or lower. Scanning documents at resolutions higher than 200 dpi
can cause image problems since fax standards only support a maximum of
200 dpi.

Selecting a scanner

The Fax Viewer supports the use of TWAIN compliant scanners for scanning
documents into fax files. If there is more than one TWAIN compatible
device installed on the machine,  select the device you want to use with
the Fax Viewer.
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To select the TWAIN device for scanning:

1. Choose Select Scanner from the File menu.

2. In the Select Source dialog, highlight the TWAIN source and click
Select.

Scanning images into a fax document

The Fax Viewer supports the ability to create a fax document by scanning
hard copy documents or images using a TWAIN compliant scanner.

To scan a document:

1. Select Scan from the File menu. You may need to choose Select
Scanner and select the TWAIN device you wish to use before selecting
Scan.

2. The TWAIN source manager for your TWAIN device appears and
presents you with the scanning options available to your TWAIN device.

3. Scan in the page or pages you wish to add to a fax document. If you
have an Automatic Document Feeder attached to your scanning
device, you will be prompted to scan each page.

4. When finished scanning your documents, close the TWAIN source
manager.

5. Select Save As from the File menu to save the scanned images as a fax
document.

Scanning images and sending it as a fax

With the Fax Viewer and a TWAIN compliant scanner, you can scan in a
hard copy document and fax it directly.

1. Select Scan from the File menu. You may need to choose Select
Scanner and select the TWAIN device you wish to use before selecting
Scan.

2. The TWAIN source manager for your TWAIN device appears and
presents you with the scanning options available to your TWAIN device.

3. Scan in the page or pages you wish to add to a fax document. If you
have an Automatic Document Feeder attached to your scanning
device, you will be prompted to scan each page.

4. When finished scanning your documents, close the TWAIN source
manager.
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5. Select Print from the File menu and select FaxTalk 4.0 as the printer.
Click OK to "print" the fax to the FaxTalk 4.0 fax driver.

6. The Send a Fax dialog or Fax Wizard appears so you can enter the fax
number you wish to send to, select a recipient from the address book
as well as attach a coversheet.

7. Click Send to send the fax.
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Chapter 9

FaxTalk Phonebook

The FaxTalk Phonebook is a convenient way to save names, fax numbers,
and phone numbers for people with whom you communicate frequently.
You can also enter useful information about them (such as a company
name or comment). The phonebook application allows you to view, add,
modify, group, and delete recipient entries. You can open the FaxTalk
Phonebook by either clicking on the phonebook icon on the FaxTalk
Communicator toolbar, or by clicking the phonebook button on the
recipient screen when sending a fax. Either method displays the
phonebook.

Figure 9-1  FaxTalk Phonebook

Adding recipients

The New Recipient dialog box contains text boxes for creating a new
phonebook entry. When you send a fax, the phonebook information is
used to fill in portions of the coversheet.
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To add a recipient:

1. Click New. The New recipient dialog appears.

Figure 9-2  New Recipient Screen

2. Enter the Name, Company, Voice, and Fax numbers of the recipient

3. Use the Comments field to add comments about the recipient such as
birthdays, anniversaries, etc.

4. Click OK to add the recipient to the phonebook.

Modifying recipient information

You can change recipient and group information at any time by selecting
the recipient or group and clicking Modify.

Deleting entries

To delete entries and groups from the phonebook, simply highlight the
entries and click Delete.

Creating groups

The phonebook includes, for convenience, the ability to group certain
recipients who will frequently receive the same fax information. This way
you only need to select a single group entry to send a fax to multiple
recipients.

To create a group:

1. Click New Group. The New Group window displays.
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Figure 9-3  New Phonebook Group Screen

2. Enter a group name in the Group Name field. This name will be
displayed in the phonebook.

3. Select any members you wish to add to the group from the Phonebook
Entries list on the left, and click Add.

4. Add any comments related to this group in the Comments field and
click OK.

Modifying Groups

You can remove members from a group by modifying the group.

To modify a group:

1. Select the group entry and click Properties. The group properties
displays.

2. To remove members from the group list, highlight them and click
Remove.

Changing how recipients are displayed in the phonebook

You can select whether you want to have names displayed in the FaxTalk
Phonebook by First Name, Last Name or Last Name, First Name.

To change how names are displayed in the phonebook:

1. Right-click on the list of recipients in the FaxTalk Phonebook.

2. Select Display Name from the right-click menu and choose either First
Name, Last Name or Last Name, First Name.
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Appendix A

License Agreement

THIS SOFTWARE LICENSE AGREEMENT CONSTITUTES AN AGREEMENT BETWEEN YOU AND THOUGHT COMMUNICATIONS, INCORPORATED (TCI).
YOU SHOULD READ CAREFULLY THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THE DISK(S) SUPPLIED. USE OF DISKS INDICATES YOUR
ACCEPTANCE OF THESE TERMS AND CONDITIONS.  IF YOU DO NOT AGREE TO BE BOUND BY THE PROVISIONS OF THIS LICENSE AGREEMENT, YOU
SHOULD RETURN PROMPTLY THE ENTIRE PRODUCT (INCLUDING ALL RELATED DOCUMENTATION AND DISKS), TO THE PLACE OF PURCHASE.

Terms and Conditions

1. GRANT OF LICENSE.  In consideration of the payment of the License Fee, which was a part of the price you paid for this product, TCI (the
“Licensor”) grants to you (the “Licensee”), a non-exclusive right to use and display this copy of a TCI software program (the “Licensed Software”)
on a single computer (i.e., with a single CPU) at a single location.  If the single computer on which you use the Licensed Software is a multi-user
system, the license herein granted covers all users on that single computer system.  TCI reserves all rights not expressly granted to Licensee in this
License Agreement.

2. OWNERSHIP OF SOFTWARE.  The license granted herein is not a sale of the original Licensed Software or of any copy of such Software.  As
Licensee, you own only the magnetic or other physical media on which the Licensed Software is originally or subsequently recorded or fixed.  TCI
retains title and ownership of the Licensed Software recorded on the original disk(s), as well as ownership of any subsequent copies of the
Licensed Software, irrespective of the form of media on or in which the Licensed Software is recorded or fixed.

3. USE RESTRICTIONS.  As Licensee, you may use the Licensed Software only as expressly authorized in this License Agreement.  You may physically
transfer the Licensed Software from one computer to another provided that the Licensed Software is used on only one computer at a time.  You
may not (i) electronically transfer the Licensed Software from one computer to another over a network; (ii) make the Licensed Software available
through a time-sharing service, network of computers, or other multiple-user arrangement; (iii) distribute copies of the Licensed Software or
related written materials to any third party; or (iv) modify, adapt, translate, reverse engineer, decompile, disassemble, or prepare any derivative
work based on the Licensed Software or any element thereof, without the express written consent of TCI.

4. COPY RESTRICTIONS.  The Licensed Software and accompanying written materials are copyrighted.  Unauthorized copying and/or distribution of
the Licensed Software and/or the related written materials is expressly forbidden.  You may be held legally responsible for any copyright
infringement that is caused, directly or indirectly, by your failure to abide by the terms of this License Agreement.  Subject to the terms of this
License Agreement, and if not otherwise copy protected, you may make one copy of the Licensed Software for backup or archival purposes only.
The copyright notice and any other proprietary notices which were included in the original Licensed Software must be reproduced and included
on any such backup or archival copy.

5. TRANSFER RESTRICTIONS.  The license herein granted is personal to you, the Licensee.  You may not transfer the Licensed Software to anyone
else, nor may you sell, lease, loan, sublicense, assign or otherwise dispose of the Licensed Software without the express written consent of TCI,
which consent may be granted or withheld at TCI’s sole discretion.

6. TERMINATION.  The license herein granted hereby will remain in effect until terminated.  This license will terminate automatically without
further notice from TCI in the event of the violation of any of the provisions hereof.  As Licensee, you agree that upon such termination you will
destroy promptly any and all copies of the Licensed Software which remain in your possession, and, upon subsequent request, will certify to such
destruction in writing to TCI.

7. LIMITATION AND DISCLAIMER OF WARRANTIES.

(A) THE LICENSED SOFTWARE AND RELATED WRITTEN MATERIALS, INCLUDING ANY INSTRUCTIONS FOR USE, ARE PROVIDED ON AN “AS IS”
BASIS, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED.  THIS DISCLAIMER OF WARRANTY EXPRESSLY INCLUDES, BUT IS NOT
LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND/OR OF FITNESS FOR A PARTICULAR PURPOSE.  NO ORAL OR WRITTEN
INFORMATION GIVEN BY TCI, ITS SUPPLIERS, DISTRIBUTORS, DEALERS, EMPLOYEES, OR AGENTS, SHALL CREATE OR OTHERWISE ENLARGE
THE SCOPE OF ANY WARRANTY HEREUNDER.  LICENSEE ASSUMES THE ENTIRE RISK AS TO THE QUALITY AND THE PERFORMANCE OF
SUCH SOFTWARE, SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU , AS LICENSEE (AND NOT TCI, ITS SUPPLIERS, DISTRIBUTORS, DEALERS,
OR AGENTS), ASSUME THE ENTIRE COST OF ALL NECESSARY CORRECTION, SERVICING, OR REPAIR.

(B) TCI warrants the diskette(s) on which the Licensed Software is recorded or fixed to be free from defects in materials and workmanship,
under normal use and service, for a period of ninety (90) days from the date of delivery as evidenced by a copy of the applicable receipt.  TCI
hereby limits the duration of any implied warranties with respect to the diskette(s) to the duration of the express warranty.  This limited
warranty shall not apply if the diskette(s) have been damaged by unreasonable use, accident, negligence, or by any other causes unrelated
to defective materials or workmanship.

(C) TCI does not warrant that the functions contained in the Licensed Software will be uninterrupted or error free and Licensee is encouraged
to test the Licensed Software for Licensee’s intended use prior to placing any reliance thereon.

(D) THE LIMITED WARRANTY SET FORTH ABOVE GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY
FROM STATE TO STATE.  SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF IMPLIED WARRANTIES OR OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE LIMITATIONS AND EXCLUSIONS CONCERNING THE LICENSED SOFTWARE AND RELATED WRITTEN
MATERIALS SET FORTH ABOVE MAY NOT APPLY TO YOU.

8. LIMITATION OF REMEDIES.  TCI’s entire liability and Licensee’s exclusive remedy shall be the replacement of any diskette not meeting the
limited warranty set forth in Subsection 7(B), above, which is returned to TCI with a copy of the applicable receipt within the warranty period.
Any replacement diskette(s) will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

9. LIMITATION OF LIABILITY.  IN NO EVENT WILL TCI OR ANYONE ELSE INVOLVED WITH THE CREATION, PRODUCTION, AND/OR DELIVERY OF
THIS SOFTWARE PRODUCT BE LIABLE TO LICENSEE OR ANY OTHER PERSON OR ENTITY FOR ANY DIRECT OR OTHER DAMAGES, INCLUDING,
WITHOUT LIMITATION, ANY INTERRUPTION OF SERVICES, LOST PROFITS, LOST SAVINGS, LOSS OF DATA, OR ANY OTHER CONSEQUENTIAL,
INCIDENTAL, SPECIAL, OR PUNITIVE DAMAGES, ARISING OUT OF THE PURCHASE, USE, INABILITY TO USE, OR OPERATION OF THE SOFTWARE,
EVEN IF TCI OR ANY AUTHORIZED TCI DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  LICENSEE ACCEPTS SAID
DISCLAIMER AS THE BASIS UPON WHICH THE SOFTWARE IS OFFERED AT THE CURRENT PRICE AND ACKNOWLEDGES THAT THE PRICE OF THE
SOFTWARE WOULD BE HIGHER IN LIEU OF SAID DISCLAIMER.  SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATIONS AND EXCLUSION MAY NOT APPLY TO YOU.
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10. UPDATES.  TCI, at its sole discretion, may periodically issue updates of the Licensed Software.  Any such updates will be made available to
Licensee, provided that Licensee prepays any applicable update fees.

11. EXPORT RESTRICTIONS.  Licensee agrees not to export or re-export the Licensed Software and accompanying documentation (or any copies
thereof) in violation of any applicable U.S. laws or regulations.

12. ENTIRE AGREEMENT.  YOU, AS LICENSEE, ACKNOWLEDGE THAT: (i) YOU HAVE READ THIS ENTIRE AGREEMENT AND AGREE TO BE BOUND BY
ITS TERMS AND CONDITIONS; (ii) THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE UNDERSTANDING BETWEEN THE
PARTIES AND SUPERSEDES ANY AND ALL PRIOR ORAL OR WRITTEN COMMUNICATIONS RELATING TO THE SUBJECT MATTER THEREOF; AND (iii)
THIS AGREEMENT MAY NOT BE MODIFIED, AMENDED, OR IN ANY WAY ALTERED EXCEPT BY A WRITING SIGNED BY BOTH YOURSELF AND TCI.

13. SEVERABILITY.  In the event that any provision of this Agreement is held to be illegal or otherwise unenforceable, such provision shall be
deemed to have been deleted from this Agreement, while the remaining provisions of this Agreement shall be unaffected and shall continue in
full force and effect.

14. GOVERNING LAW.  This Agreement shall be governed by the laws of the State of California and of the United States of America, excluding that
body of law related to choice of laws.


